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1 Introduction
This document provides information necessary to install and operate GreenDash™ on your computer. It
is a step-by-step guide on how to install the software and register the product on your system.
Z2 Installation
The sequence of steps to install GreenDash™ on your computer is as follows:
1. Install Driver for the OWL +USB Monitor
2. Connect the OWL +USB Monitor
3. Install GreenDash Software
g Please note that the driver for the OWL +USB Monitor has to be installed before it is plugged in and
before GreenDash software is installed. It is important that you install the software on a system where
you have logged in with Administrator privileges.
Each of these steps is detailed below in Sections below [Ref to 2.2, Error! Reference source not found.,
2.4]
g lf GreenDash is already installed on your PC, you must first uninstall (refer to Section 5) all components
before installing the new version.
2.1 System Requirements
2.1.1 Operating System
- Microsoft® Windows XP
- Microsoft® Windows 2000
- Microsoft® Windows Vista
- Microsoft® Windows 7
2.1.2 Hardware
- 500Mhz or faster Processor
- 4MBor more total RAM and 16MB available RAM
- 50MB free drive space
2.1.3 The OWL +USB Monitor
2.1.4 Browsers Supported
Any browser which supports Adobe Flash Player v8.0 or higher
- Internet Explorer 6.0 or higher
- Mozilla Firefox 1.x or higher
- Google Chrome
- Netscape 7.x or higher
2.1.5 Network
- Internet Connection (256kbit or higher broadband recommended)
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2.2 Driver Installation
Please note that the setup process needs Administrator privileges to be able to perform driver
installation.
Run the installation program DriverInstaller.exe, Figure 1, to install the drivers for the Owl +USB device.
Figure 1: USB Driver Installer
(a drivers | P' Go
x a Biel | +) 1x64 €9 DriverUninstaller exe EI slabycp. inf
Fi OWL plug LSE Install = | Li a xB [5 seCup. ini
Sy drivers ~ : #2 DriverInstaller.exe ES slabvcp.cat
— — drivers wl «| ‘
61 (Disk free space: 0 bytes) 260 KB Loa) My Compuber ;
There may be a Windows warning, shown in Figure 2, while installing the driver, indicating that Microsoft
has not certified and digitally signed this driver. This warning does not reflect on the quality or
functionality of the driver.
Figure 2: Windows Logo Testing Warning
[Software Installation
aN The software you are installing has not passed Windows Logo
testing to very its compatibility with this version of Windows. [Tell
me why this testing 1 important. |
Continuing your installation of this software may impair
or destabilize the comnect operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the software vendor for software that haz
passed Windows Logo testing.
Continue Angway |}? STOP Installation :
If you see this warning, simply ignore the warning and click "Continue Anyway" or Install this driver
software anyway” button in the Windows Security Dialog Box, and continue with the standard
installation process. Follow the on-screen instructions to proceed through the installation.
When The software for this device has been successfully installed” or Installation is complete”
window appears, click Close” or Finish”.
At the end of the installation, you may be prompted to reboot your computer. Restart your PC.
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2.3 Connect the OWL +USB Monitor
To complete this step, you must log in to the PC as an Administrator or using an account with
Administrator privileges. Connect the USB cable provided to the OWL +USB Monitor and an available
USB port on the computer. Windows will automatically detect the new hardware and use the correct
drivers, as shown in Figure 3 below.
Figure 3: New Hardware Detection
Y OWL Wireless Electricity Monitor USB version is connected
lnstallirig ...
The new hardware will be appear in the list of connected devices, refer to Figure 4.
Figure 4: Hardware List
ae Keyboards
ey Mice and other pointing devices
| Network adapters
if Ports (COM & LPT)
| oe Communications Pork (COMES)
| oe Communications Pork (COM6)
| seen OWL Wireless Electricity Monitor USB version is connected (COM?)
oo SY! Printeragort (LPT
+)€6 SCS] and RAID controllers
 | Cancel
with user-friendly, easy to customize energy dashboards
on existing devices - at home, away or abroad.
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Step 2. Select Installation Type
Before beginning your installation of the GreenDash Hub, decide the type of installation required. The
options for installation, as seen in Figure 7, are:
(a) Typical (b) Custom (c) Complete
Figure 7: Installation Type
—— wy HOME ENERGY |
sone | MY HOME ENER
ro oe 8 0 Qf
a
Curent Graphs (i GreenDash Hub for Owl+USB 1.0 Setup
Choose Setup Type
Choose the setup byoe that best suits your needs
Typical
Installs the most common program Features, Recommended For
most users,
Custom
Allows users to choose which program Features will be installed
and where they will be installed, Recommended for advanced
USers.
Complete
4ll program Features will be installed, (Requires most disk
space!
oe
a Advanced Installer
CaaterPaiat Laergy
HT
METER MULE
=< Back, exh =
irda
If you choose the ‘Typical’ or ‘Complete’ setup option, you will see the Ready to Install" dialog as in
Figure 9.
In case you choose the ‘Custom’ setup, you will be prompted with the feature selection dialog, as shown
in Figure 8. The listed features are:
o Browser Shortcuts
Shortcuts to default URL addresses to access the GreenDash System
o Desktop Dashboards
Windows applications that show Dashboards natively on the Windows desktop. These are stand-alone
Dashboards and do not require a browser.
o Main Feature
Primary component GreenDash Hub
o Service
o Windows service that can be configured to start when PC is booted and run in the background as long
as Windows is running.
o Sample Setup
Sample list of devices or sensors used to test the system, and associated setup files.
o Sample Sensor Data
Sample sensor power usage data/meter readings for sample devices. This feature cannot be selected
and installed if ‘Sample Setup’ feature is not selected.
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a) Typical Installation Option
Use the Typical Installation option to install the minimum required modules to run GreenDash. This is
the recommended mode of installation for most users. This option installs the following basic
components:
— Browser Shortcuts
— Main Feature
— Service
b) Custom Installation Option
Use the Custom installation option in the following scenarios:
— To install Sample Device List or Sensor List
— To install Desktop Dashboards
In this mode, you can select the features as well as the installation path. This is recommended for
use only by advanced users. This installs one or more (as you choose) of the following components:
— Browser Shortcuts
— Sample Setup
— Sample Sensor Data
— Desktop Dashboards
— Main Feature
— Service
Upon selecting ‘Custom’ Installation, the following window appears (Figure 8), with option to select
features as well as the path for installation.
Figure 8: Custom Setup Options
een Pele Ret
Custom Setup
Select the way you wank Features to be installed,
Click on Fhe icons in the tree below to change the way Features will be installed,
SS
A seen +) Sample Setup
fences IE ~| Sample Sensor Data
oo RT Desktop Dashboards This Feature requires 20KB on your
Description
| ceveneee (=) + | MainFeature hard drive,
Lesaeeees =) =) Service
Location: CiProgram FilestFutureDashioreenDash Browse... |
Advanced Installer
Reset Disk Usage < Back Hext > Cancel |
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To enable/disable a feature, click on the small drop-down arrow next to the feature and select the
desired option. Please note that some features are required for the software to work and thus
cannot be disabled.
The default path for installation is C:\Program Files\FutureDash\GreenDash. To select an alternate
path, click Browse” and choose the path for installation.
c) Complete Installation Option
Use the Complete installation option in order to have all the features installed and for support of all
types of GreenDash modules. This option installs all of the following components:
— Browser Shortcuts
— Sample Setup
— Sample Sensor Data
— Desktop Dashboards
— Main Feature
— Service
Step 3. Begin Installation
Once the type of installation is selected, the ‘Ready to Install’ dialog appears as in Figure 9. Click Install”
to begin the installation.
Figure 9: Ready to Install
Monitor and manage your electricity at home or away.
View current usage in real time plus historical trends.
AND sa vc LLL nl xc
Ready to Install
The Setup Wizard is ready bo begin the SGreenDash Hub For Gwl+U56 1.0 installation
Click "Install" bo begin the installation, IF you want bo review or change any oF your
installation settings, click "Back", Click Cancel” to exit the wizard.
, OG Advanced Installer
denterteist Laergy
a
siete i Lee E
< Back
ttrdn
The installation process may take several minutes; the progress status will be displayed as in Figure 10.
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Figure 10: Installation Progress
Setup & receive your own —
2 PowerMoter: Energy User's Ham
text or email energy alerts ... Qiachtety wes Gey deca 206
Howe, Peoat-timg =
ie GreenDash Hub for Owl+U5B 1.0 Setup
Installing GreenDash Hub for Owl+U56 1.0
Please wait while the Setup Wizard installs GreenDash Hub For Owl+US6 1.0. This
may take several minutes,
Status: Copying new Files
aaa
Advanced Installer
with user-friendly, easy to customize energy dashboards
on existing devices - at home, away or abroad.
Step 4. Finish Installation
When the installation is complete, the following screen appears (Figure 11). Click Finish” to exit the
installation. It is recommended that you read the ReadMe File.
Figure 11: Finish Installation
ji GreenDash Hub for Owl+USB 1.0 Setup x!
Completing the GreenDash
Hub for Owl+USB 1.0 Setup
Wizard
Click Ehe "Finish" butkon bo exit the Setup Wizard,
Iv View readme File
= Back: Finish Cancel
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Please note that a Windows Firewall Warning” message may pop up (Figure 12) during installation
(unless you have selected to not install as a service) or at the launch of the GreenDash Hub Program.
Click Allow” or Unblock” to enable the application to access the network.
Figure 12: Windows Firewall Warning
cee etme a X|
To help protect your computer, Windows Firewall has blocked
some features of this program.
Do you want to keep blocking this program?
~~) Name: dashserver
Publisher Unknown
Keep Blocking Unblock, 4sk MMe Later
For more information about blocking and unblocking a program, see the Microsoft
Web site,
If Windows Firewall is enabled on your computer and if there is no such warning message during
installation or on running the program, then you must click on ‘Add Program’ on ‘Exceptions’ Tab on the
Windows Firewall window and include ‘greendashhub.exe’ to the list of allowed applications, as shown in
the figure below.
Figure 13: List of Allowed Applications
ee Trin ae ees eT
General) Exceptions | Advanced
Windows Firewall is blocking incoming network connections, except for the
programs and services selected below. Adding exceptions allows some programs
to Work, beter but might increase your security risk.
Programs and Services:
Name
File and Printer Sharing
Java(TM] Platform SE binary
Network, Diagnostics for Windows XP
Remote Assistance
[7] Remote Desktop
LO UPnP Frarniework,
| Add Program... | | AddPort.. | { Edit...
Display a notification when Windowe Firewall blacks 4 program
What are the rieks of allowing exceptions?
OK. | Cancel
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If your computer has firewall software other than Windows Firewall, consult the documentation that
came with your firewall software and follow the instructions to add ‘GreenDashHub.exe’ to the list of
applications allowed to access the network.
2.5 Installation Verification
To verify the software installation, click on the ‘Start’ button and navigate to the ‘FutureDash’ program
group in the program menu (Start > All Programs > FutureDash on computers running Windows Vista
or Windows 7). You should be able to see the following shortcuts:
GreenDash Hub
GreenDash Home
Dashboard Manager
You can also verify your installation by making sure that files were installed to the desired installation
directory.
Accessing these URLs, either from the Start Menu (Figure 14), or by entering these URL addresses in a
browser, is your main access point to the GreenDash System:
GreenDash Home: http://localhost:8081/mother/index.php
GreenDash Setup/Preferences: http://localhost:8081/mother/ad/72-106/Setup/dashprefs.swf
Dashboard Manager: http://localhost:8081/mother/dashmanager/dashManager.swf
Figure 14: Start Menu- Programs - GreenDash
bee Pe Po ma"!
)-487 Local Users and Groups Alternative Launch Modes =
ra Storage ‘| Dashboard Manager
~~] Disk Management @) GreenDash Home
te Set Program 4ccess and Defaults a GreenDash Preferences 4
; wy BlueDash. exe
ae vances Haare ew BlueDash-WholeHome.exe
a: Winzip Desktop Dashboards
| GreenDash Hub
Internet Explorer =| ReadMe.txt
(ea) Qutloak, Express bei) WaterDash.exe
Programs
Documents . = Realvic » (oy WaterDash-WholeHome.exe
| ger b f= GreenDash EULA. rtF
Settings |
Search F
Help
Run...
Cy) Shut Down...
Start ll ia & ea i) [ ‘yGreenDash | 2 windows fi | 3) computer a GN c:\wanvnr...| ay
If you chose ‘Typical’ installation, ‘Complete’ installation OR ‘Custom’ installation and included ‘Service’
feature for installation, the GreenDash Hub service should normally be visible in Windows Services
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Management Console (Contro! Panel > Administrative Tools > Services on Windows XP and Windows
2000, Control Panel > Classic View > Administrative Tools > Service on Windows Vista and Windows
7). |f this service does not appear in the list of active services, refer to the FAQ & Troubleshooting Guide.
3 Product Activation
1. If GreenDash Hub is not already installed as a service (custom installation where ‘Service’ was not
selected), then you need to first launch GreenDash Hub program from Start Menu.
g In the case of Typical installation, Complete installation or Custom installation with ‘Service
selected, the GreenDash Hub will already be running in the background. DO NOT launch GreenDash
Hub (GreenDashHub.exe) from the Start Menu unless the service is first stopped.
2. Launch the GreenDash Home page. Go to Start > Programs FutureDash > GreenDash Home
(Windows XP and Windows 2000) or Start > All Programs FutureDash > GreenDash Home
(Windows Vista and Windows 7).
3. This opens the GreenDash Home page in a browser. You should be automatically directed to the
Registration & Login Page.
}
Figure 15: Registration Page
Oiatrdl|enaies ie
File Edit View History Bookmarks Tools Help
-" ¢ fay | ||) | http: i#127.0.0, 1:8081 mother
[63] Mosk visited | Getting Started Latest Headlines
| FE http: /127.0.0.1:3081 /mother; | oe
Erna:
First name:
Last name:
Cellphone:
Reqister |
4. Register on the website and create your account to log in, or use your existing login if you are already
a member of the site. On log in, please enter your contact details here and submit the form to
complete the activation of your software. The license is registered to the user account created to log
in to the website.
g Please remember to keep your contact details updated on this site in order to receive notifications
and updates.
With your product now activated, you will be directed to the initial setup wizard, as shown in Figure 16.
Follow the instructions there to complete the GreenDash Setup (refer to Section 4). In case you are not
automatically directed to this page, refer to the FAQ and Troubleshooting Guide.
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Figure 16: Link to GreenDash Setup Wizard
”) Mozilla Firefox
File Edit View History Bookmarks Tools Help
o 7 Cc mm Th | |) | http: //127.0.0. 1:8081 mother register
Mosk visited FR Getting Started Latest Headlines
| | http://127.0.0.1:8...1/mother/register | |
Account created, tollow to your:
(sreenLiash
4 GreenDash Dashboard - Basic Setup
Once GreenDash software is registered, click on the link ‘GreenDash’ seen in Figure 16 and you will be
directed to the home page (shown in Figure 17).
Figure 17: GreenDash HomePage
”) GreenDash - Mozilla Firefox
File = Edit View History Bookmarks Tools Help
ae * Cc 4 ¢ay | | nttp:4/127.0.0.1:8081/mother/al/
Most Visited b Getting Started Latest Headlines
| Lb GreenDash | = |
GreenDash Energy Management System
All Dashboards:
Configuration:
e GreenDash Setup
e Setup Wizard
® Dashboard Manager
9
e In order to view energy consumption information, it is important to set up a dashboard for viewing
real-time data. Click on the link ‘Dashboard Manager’ to create a custom Dashboard or to choose one
from the wide range of Dashboard Templates. You will be directed to the Dashboard Manager page
(seen in Figure 18).
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Figure 18: Dashboard Manager
{ dashmanager.swf (application; x-sh... |
Usage Graph - 24 Hours Usage Graph - 24
Usage Graph - 24 Hours [_] visible Usage Graph - 24H
Budget Usage Graph - 3M
Usage Graph - 3 Manths [_] visio Usage Graph - 3 Mee
Usage Tables - Month Usage Tables - Mon)
Usage Tables - Month [_] vesiote Usage Tables - sore
Cycle Usage Graph - 1 Ho
Usage Cycle [_] ¥istole Usage Graph - 1 io
Clock Usage Graph - 8 H
Usage Clock [_] visivte Usage Graph - 8 Hoe
Month3 Usage Clack aon
Blue Dash Usage Graph - 3 Months [_] visite Usage Clock as)
Blue Dash
Hour Usage Cycle merce
cune bes New Usage Graph - 1 Hour Sn) (a) veo Usage Cycle =
ie
Green Dash ee
Green Dash
BlueDash Whole Home ee
BlueDash Whole Home
Choose one of the existing templates, click on ‘New’. The selected dashboard will appear in the top-left
box on the page. Click ‘Edit’ if you would like to personalize your dashboard. Then click ‘Save’.
Figure 19: Create New Dashboard
| dashmanager.swf (application, -sh... [ =|
Dashboard Manager
( Dashboards otis iz Dashboard Properties
BlueDash Whole Home
BlueDash Whole Home
(tony | (Remove
ae
== as
Lt Mater trp PWT ls materia
Usage Graph - 24 Hours [4] Usage Graph - 24
Usage Graph - 24 Hours [_] Veiote Usage Graph - 24H
Budget Usage Graph - 37M
Usage Graph - 3 Manths Ses) [ill ence Usage Graph - 3 tere
Usage Tables - Month Usage Tables - Monge)
Usage Tables - Month ers) [|| vee Usage Tables - sane eel)
Cycle Usage Graph - 1 Hos
Usage Cycle Sete) [ual vote Usage Graph - 1 he)
== Clock Usage Graph - 8H
= Tem Be Usage Clock Say ual) Vaile Usage Graph - 8 Nou
Month3 Usage Clock wr
Blue Dash Usage Graph - 3 Months Remove la) Vasile Usage Clock ers
Blue Dash
Hour Usage Cycle er
Cube Dash Usage Graph - 1 Hour Remove Mo" Usage Cycle Le)
Cube Dash
Green Dash
Green Dash
BlueDash Whole Home
BlueDash Whole Home
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Once the dashboard is selected, go back to GreenDash home page by clicking browser navigation back
button. Refresh the page. The newly selected Dashboard will appear under the list ‘A// Dashboards’.
Figure 20: GreenDash - All Dashboards
FE GreenDash|
GreenDash Energy Management System
All Dashboards:
e179 - BlueDash Whole Home
Configuration:
e CreenUash setup
e metup Wizard
e Dashboard Manager
Other:
® Account
@ Help
g Note that the Dashboard is still not accessible on this page. The link to the Dashboard will become
active only once GreenDash is ‘regenerated’. In order to ‘regenerate’ GreenDash, click on the link
GreenDash Setup’ as seen in Figure 20. You will be directed to the GreenDash Setup page, as shown in
Figure 21.
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Figure 21: GreenDash Setup page
| (4 dashprefs.swf (application,’x-shock... + |
. . a — a
Basic Settings | Advanced Settings | Devices and Data | Misc Settings | Regenerate|
?" y" ~"
| General | Key Management | Webservice | HTTP Server | Data Feed |
Geographic Location: Latitude: | 40 Longitude: | a?
UTC Clock on Host: [J Enabled
Time Zone Settings: |-9700 Daylight Savings Time: [Mm Enabled
Time Format: | hhirmmiss | :|
Date Format: | vuyermm-dd | :|
Default Language: | English | :|
Help Roewert Save settings
g If ‘UTC Clock on Host’ is enabled, untick the box to disable this on Windows systems.
Most other settings are set to the default values and you should be able to access the Dashboard and
view live date with the default settings.
g Click on ‘Regenerate’ button at the top-right end of the page to activate the link to the Dashboard.
Wait until the regeneration is complete and ‘Regeneration Request Successful’ status appears - see
Figure 22. This can take up to one minute. In case, regeneration is not successful, refer to the FAQ &
Troubleshooting Guide.
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Figure 22: Regeneration Successful
{4 dashprefs.swf (application,/x-shock... +
. . ie ‘i hy
Basic Settings | Advanced Settings | Devices and Data | Misc Settings | Regenerate|
* a 4 yr al hy
| General | Key Management | Webservice | HTTP Server | Data Feed |
Geographic Location: Latitude: | 40 Longitude: | a2
V2 Regeneration Results ci uaaaannamm mg | Goelaler
Regenerate request successful, ; [4 Enabled
Number of actions: a
| Number of devices: 12 id
Number of variables: eye -
Number of dashboards: 1 3]
[ Dashboard - BlueDash Whole Home BlueQash ¥Whole Horm él
Regenerate Log: ;
OwltUSeB Device Detected
Help Poe wert Save settings
Again, navigate back to the GreenDash home page. The link to the Dashboard will now be active.
Figure 23: Dashboard- active link
GreenDash Energy Management System
All Dashboards:
e 179 - BlueDash Whole Home - BElueDash Whole Home
Configuration:
@ (reenDash Setup
@ Setup Wizard
@ Dashboard Manager
Click on this link to view the Dashboard. The ‘BlueDash Whole Home’ Dashboard will appear as shown in
Figure 24.
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Figure 24: BlueDash Dashboard
ry - — METAB
+ ; | _ vi
_ \ ) Meters
Current Graphs Statistics Notes el ’
Price: $0.22 /kWh
$3.55 Per Day
Today's Cost: $0.00
Total Today: 0.03 kWh
This Week's Usage: 0 kWh
This Month's Usage: 0 kWh & y
This Month's Cost: $0.00 Whole House
Energy Management Home State Language:English Copyright © 2010, FutureDash
You can now view real-time data on energy consumption, various statistics, and cost of energy
consumption on individual sensors and across the whole house.
5 Uninstallation
To uninstall the software, you must first close the application if you have it running as a result of
manually launching the application.
Follow the Windows standard uninstallation process. Go to Control Panel > Add/Remove Programs (or
Programs and Features). Select or click on GreenDash Hub [Version] program in the ‘Currently installed
programs’ box. Next, click ‘Remove’. If you are prompted to confirm the removal of the program,
click ‘Yes’.
g Please note that uninstalling the software will also remove usage data and other data files created by
GreenDash Hub.
6 Installation Updates/FAQs
Refer to FAQ/Troubleshooting Guide in case you have any issues with the installation process. It can be
found at Start > Programs> FutureDash > FAQ_TroubleshootingGuide_GD2051.pdf and is also
available in the installed folder.
For more information on the product or for details on software updates for the product, visit our website
at http://futuredash.com/support/GD2051.
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